Imprint

Information in this document is subject to change without notice. No part of this document may be reproduced or transmitted without the express written permission of Multi Channel Systems MCS GmbH.

While every precaution has been taken in the preparation of this document, the publisher and the author assume no responsibility for errors or omissions, or for damages resulting from the use of information contained in this document or from the use of programs and source code that may accompany it.

In no event shall the publisher and the author be liable for any loss of profit or any other commercial damage caused or alleged to have been caused directly or indirectly by this document.

© 2019 Multi Channel Systems MCS GmbH. All rights reserved.

Printed: 07.01.2019

Multi Channel Systems MCS GmbH
Aspenhaustraße 21
72770 Reutlingen
Germany

Phone +49-71 21-909 25 - 0
Fax +49-71 21-909 25 -11

sales@multichannelsystems.com
www.multichannelsystems.com

Microsoft and Windows are registered trademarks of Microsoft Corporation. Products that are referred to in this document may be either trademarks and/or registered trademarks of their respective holders and should be noted as such. The publisher and the author make no claim to these trademark.
# Table of Contents

1 **Important Information and Instructions** ................................................................. 5  
  1.1 Operator’s Obligations .......................................................................................... 5  
  1.2 Guarantee and Liability ......................................................................................... 5  
  1.3 Important Safety Advice ....................................................................................... 6  
2 **Welcome to the STG4002-opto** ............................................................................ 8  
3 **Installing the Software** ........................................................................................ 10  
4 **Setting Up and Connecting the STG4002-opto** .................................................... 11  
5 **General Software Features** .................................................................................. 13  
  5.1 Menus .................................................................................................................. 13  
    5.1.1 File Menu ....................................................................................................... 15  
    5.1.2 Edit Menu ..................................................................................................... 16  
    5.1.3 STG Menu .................................................................................................... 17  
    5.1.4 Batch Menu .................................................................................................. 17  
    5.1.5 Signal Menu .................................................................................................. 17  
    5.1.6 View Menu ................................................................................................... 18  
    5.1.7 Window Menu .............................................................................................. 18  
    5.1.8 Settings Menu ............................................................................................... 18  
    5.1.9 Help Menu .................................................................................................... 19  
6 **Operating the STG4002-opto** ............................................................................... 20  
  6.1 Operation Overview ............................................................................................. 20  
    6.1.1 Autocalibration .............................................................................................. 22  
    6.1.2 Operating multiple STGs ............................................................................... 23  
7 **MC_Stimulus II Worksheet** .................................................................................. 24  
  7.1 Pulse Types ......................................................................................................... 25  
    7.1.1 Auto Sync for Autocreating Trigger Pulses .................................................. 28  
    7.1.2 Adjusting the Stimulus Intensity Level .......................................................... 29  
  7.2 Stimulus Display .................................................................................................. 30  
    7.2.1 Selecting Channels ....................................................................................... 30  
    7.2.2 Display Settings ............................................................................................ 30  
    7.2.3 Display Tools ................................................................................................ 30  
  7.3 Downloading Stimulus Files ................................................................................ 31
8 Synchronizing Events .............................................................................................................. 32
  8.1 Trigger Settings .................................................................................................................. 34
    8.1.1 Standard Mode ........................................................................................................... 34
  8.1.2 Multi File Mode ............................................................................................................ 36
  8.1.3 Batch Mode .................................................................................................................. 38
  8.1.4 Auto Sync for Autocreating Trigger Pulses ................................................................. 40
9 Troubleshooting ..................................................................................................................... 42
  9.1 Errors .............................................................................................................................. 43
10 Technical Specifications ........................................................................................................ 44
11 Contact Information ............................................................................................................. 45
1 Important Information and Instructions

1.1 Operator's Obligations

The operator is obliged to allow only persons to work on the device, who
• are familiar with the safety at work and accident prevention regulations and have been instructed how to use the device;
• are professionally qualified or have specialist knowledge and training and have received instruction in the use of the device;
• have read and understood the chapter on safety and the warning instructions in this manual and confirmed this with their signature.

It must be monitored at regular intervals that the operating personnel are working safely. Personnel still undergoing training may only work on the device under the supervision of an experienced person.

1.2 Guarantee and Liability

The General conditions of sale and delivery of Multi Channel Systems MCS GmbH always apply. The operator will receive these no later than on conclusion of the contract. Multi Channel Systems MCS GmbH makes no guarantee as to the accuracy of any and all tests and data generated by the use of the device or the software. It is up to the user to use good laboratory practice to establish the validity of his findings.

Guarantee and liability claims in the event of injury or material damage are excluded when they are the result of one of the following.
• Improper use of the device.
• Improper installation, commissioning, operation or maintenance of the device.
• Operating the device when the safety and protective devices are defective and/or inoperable.
• Non-observance of the instructions in the manual with regard to transport, storage, installation, commissioning, operation or maintenance of the device.
• Unauthorized structural alterations to the device.
• Unauthorized modifications to the system settings.
• Inadequate monitoring of device components subject to wear.
• Improperly executed and unauthorized repairs.
• Unauthorized opening of the device or its components.
• Catastrophic events due to the effect of foreign bodies or acts of God.
1.3 Important Safety Advice

Warning: Make sure to read the following advice prior to install or to use the device and the software. If you do not fulfill all requirements stated below, this may lead to malfunctions or breakage of connected hardware, or even fatal injuries.

Warning: Obey always the rules of local regulations and laws. Only qualified personnel should be allowed to perform laboratory work. Work according to good laboratory practice to obtain best results and to minimize risks. The product has been built to the state of the art and in accordance with recognized safety engineering rules.

The device may only
• be used for its intended purpose;
• be used when in a perfect condition.
• Improper use could lead to serious, even fatal injuries to the user or third parties and damage to the device itself or other material damage.

Warning: The device and the software are not intended for medical uses and must not be used on humans. MCS assumes no responsibility in any case of contravention. Malfunctions which could impair safety should be rectified immediately.

High Voltage

Electrical cords must be properly laid and installed. The length and quality of the cords must be in accordance with local provisions.

Only qualified technicians may work on the electrical system. It is essential that the accident prevention regulations and those of the employers’ liability associations are observed.

• Each time before starting up, make sure that the mains supply agrees with the specifications of the product.
• Check the power cord for damage each time the site is changed. Damaged power cords should be replaced immediately and may never be reused.
• Check the leads for damage. Damaged leads should be replaced immediately and may never be reused.
• Do not try to insert anything sharp or metallic into the vents or the case.
• Liquids may cause short circuits or other damage. Keep the device and the power cords always dry. Do not handle it with wet hands.
Requirements for the installation
Make sure that the device is not exposed to direct sunlight. Do not place anything on top of the device, and do not place it on top of another heat producing device. Otherwise, the device may overheat.

Terms of Use for MC_Stimulus II
You are free to use MC_Stimulus II for its intended purpose. You agree that you will not decompile, reverse engineer, or otherwise attempt to discover the source code of the software.

Limitation of Liability
Multi Channel Systems MCS GmbH makes no guarantee as to the accuracy of any and all tests and data generated by the use the MC_Stimulus II software. It is up to the user to use good laboratory practice to establish the validity of his findings.

To the maximum extent permitted by applicable law, in no event shall Multi Channel Systems MCS GmbH or its suppliers be liable for any special, incidental, indirect, or consequential damages whatsoever (including, without limitation, injuries, damages for data loss, loss of business profits, business interruption, loss of business information, or any other pecuniary loss) arising out of the use of or inability to use MC_Stimulus II or the provision of or failure to provide Support Services, even if Multi Channel Systems MCS GmbH has been advised of the possibility of such damages.
2 Welcome to the STG4002-opto

The STG4002-1.6A-opto is a 2-channel stimulus generator for current-driven electrical stimulation of high power LEDs used for optical experiments in combination with a LED stimulator device and a MEA2100-System. LED stimulator devices and MEA2100-Systems are available with one or two slots.

STG4002-1.6A-opto connected to a LED Stimulator for MEA2100-Systems with one slot for MEAs.

LED Stimulator for MEA2100-Systems with two slots for microelectrode arrays.
MC_Stimulus II, Version 3.5.0

Stimuli are created user friendly by entering the desired positive pulses into a worksheet. The height and the duration of the pulses can be combined freely to create virtually different stimulus pattern.

Created stimuli are displayed in a WYSIWYG stimulus display. Both channels are set up separately.

For even more convenience, repetitive stimulus patterns do not have to be entered separately, but can be grouped and looped. You can also import waveforms in ASCII file format and use them for stimulation. You can print and save stimuli and comments for later use and documentation of your experiments.
3 Installing the Software

Driver Installation

The stimulus generator is a plug and play device. The driver is automatically installed together with the MC_Stimulus II program. For operating the STG4002-opto, Version 3.5.0 or higher is necessary.

The Microsoft Windows ® operating system detects a new hardware when the stimulus generator is connected to the computer, if the program has not been installed beforehand. Simply cancel the driver installation and proceed with the installation of the MC_Stimulus II program.

Important: Please make sure that you have full control over your computer as an administrator. Otherwise, it is possible that the installed hardware does not work properly. If there are any problems, and you need to install or update the driver manually, please see the MC_Stimulus II help for more information.

Installing the Software

System requirements

Software: One of the following Microsoft Windows ® operating systems is required: Windows 10, 8 and 7, Vista or Windows XP (English and German versions supported).

Hardware: USB port (2.0 High Speed)

Please check the system requirements before you install the software. MCS cannot guarantee that the software works properly if these requirements are not fulfilled.

Important: Please make sure that you have full control over your computer as an administrator. Otherwise, it is possible that the installed software does not work properly.

1. Double click Setup.exe on the installation volume. The installation assistant will show up and guide you through the installation procedure.

2. Follow the instructions of the installation assistant.

After finishing the installation of the MC_Stimulus II software and the STG driver, you can operate the STG4002-opto.
4 Setting Up and Connecting the STG4002-opto

Provide a power supply and a computer with USB port in the immediate vicinity of the installation site. Make sure the STG is switched off before you connect it to the power supply.
1. Place the STG on a stable surface, where the air can circulate freely and the STG is not exposed to direct sunlight.

2. Connect the external power supply to the STG.

3. Connect the external power supply to the power outlet.

4. Connect the USB connector to the USB port of the computer. The computer connection is necessary for programming the STG, but not for operating it, with the exception of the Batch mode.

5. Connect the + and - plugs of the required output channels with 2 mm plug cables to the LED Stimulator device. Connect the appropriate ground to the ground input of the stimulation setup, for example, to the ground input of the MEA2100 amplifier.

6. Optional: Connect the required Trigger In inputs with BNC cables to instruments that produce TTL signals for triggering the STG.

7. Optional: Connect the required Sync Out outputs with BNC cables to following instruments that you want to be triggered by TTL signals from the STG, for example to one of the 16 digital inputs of the MCS-IFB Multiboot interface board of the MEA2100-System.

8. Switch the STG on by pressing the toggle switch on the rear panel.

9. Select the respective STG via software.

Click option "STG Device Setup" in the "Settings" menu.

Please select the appropriate device type according to the connected STG from the drop down menu.
5 General Software Features

Customizing the Main Window
You can customize the size and position of open file windows and the toolbar in MC_Stimulus II.

- You can hide the toolbar and the status bar by deselecting them on the View menu.
- You can arrange the windows with the commands on the Window menu.

Cascade: Use this command to arrange multiple opened windows in an overlapped fashion. The windows are resized to the standard size.

Tile: Use this command to arrange the windows so that they are not overlapping.

Arrange Icons: Use this command to line up minimized windows.
- You can resize the windows with your mouse.
- Click an empty area on the toolbar, and then drag the toolbar to a new position.

Menu Bar
You will find most software features in the drop down menus of the main window. Each menu displays a list of commands. Commands that are not available at the moment appear shaded.

Use the ...

File menu to create new files, save files, import ASCII files, and print the stimulus worksheet.

Edit menu for general editing features like copy and paste rows, remove the last entered value (Undo), remove and insert rows into the active worksheet. You can also right-click on a row and select these commands. Click Clear Signal to delete all values in the active worksheet. You can also specify the output ranges according to the connected STG on this menu. Please see the technical specifications of your STG.

The STG menu contains all commands directly relating to the hardware, for example download commands, start and stop the STG, and trigger configurations.

You can open, start, and stop a batch run of several files on the Batch menu.

Signal menu for nice editing features like editing whole columns, and autocreate signals. You can also right-click on a column and select these commands.

View and Window menu to customize the main window.

Settings menu to define general settings of the software.

Help menu to open the MC_Stimulus II Help and to display the “About” dialog where you can find information about the hardware, software, and firmware versions. You will need this information when you contact the support.
Toolbar

For your convenience, you will find some of the more commonly used commands as a button on the toolbar.

CTRL+N  New File  Creates a new MC_Stimulus II file (*.stm) file.
CTRL+O  Open File  Opens a previously saved MC_Stimulus II file (*.stm) file.
CTRL+S  Save File  Saves a MC_Stimulus II (*.stm) file to the chosen destination.
CTRL+X  Cut Row  Deletes selected row(s) and sends deleted row(s) to clipboard.
CTRL+C  Copy Row  Sends selected row(s) to clipboard.
CTRL+V  Paste Row  Pastes row(s) from clipboard and overwrites row(s) starting at the selected row.
CTRL+P  Print  Prints active channel of active worksheet.
CTRL+D  Information  Opens the About dialog, where you can find information about the hardware, software, and firmware versions.
CTRL+A  Download  Downloads stimulation file to the connected STG (only available if the STG has active computer connection).
CTRL+R  Download and Start  Downloads and starts stimulation file to the connected STG (only available if the STG has active computer connection).
CTRL+T  Start  Starts downloaded stimulation file (only available if the STG has active computer connection).
CTRL+T  Stop  Stops downloaded stimulation file (only available if the STG has active computer connection).

Shortcut Keys

Shortcut keys offer you another way to accomplish common tasks. Using a shortcut key usually consists of pressing and holding one key while pressing a second key. See the list of shortcut keys available in the software in the table above.
5.1 Menus

5.1.1 File Menu

<table>
<thead>
<tr>
<th>File</th>
<th>Edit</th>
<th>STG</th>
<th>Batch</th>
<th>Signal</th>
<th>View</th>
<th>Window</th>
</tr>
</thead>
<tbody>
<tr>
<td>New</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Ctrl+N</td>
</tr>
<tr>
<td>Open</td>
<td>Ctrl+O</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Close</td>
<td>Ctrl+S</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Save</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Save As</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Import ASCII File</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Export ASCII File</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Print</td>
<td>Ctrl+P</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Print Preview</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Print Setup</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Exit</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

You can save MC_Stimulus II files for later use. This is very convenient if you have various similar experimental setups, or if you like to repeat an experiment later.

Open a file
You may open previously saved files for similar experimental setups.
1. On the File menu or on the toolbar, click Open.
2. Browse your folders and choose the desired file. You may only open MC_Stimulus II files (*.stm).
3. Click Open. The selected file opens.

Save a file
1. On the File menu or on the toolbar, click Save. The currently active worksheet is now saved.
You may open the file using MC_Stimulus II later on to continue your experiment.

Save as
Use this command to save your file under a new name, for example, if you like to use a file as a template for a new file.
1. On the File menu, click Save As.
2. Browse your folders and enter a file name.
3. Click Save. The current worksheet is now saved under the new name.
You may open the file using MC_Stimulus II later on to continue your experiment.

Import ASCII File

Export ASCII File

Printing a channel
1. On the File menu, click Print Setup to select a printer, paper format, and so on.
2. Click Print Preview to preview the print output.
3. Click Print to print out the active channel of the active worksheet.
## 5.1.2 Edit Menu

<table>
<thead>
<tr>
<th>Edit</th>
<th>STG</th>
<th>Batch</th>
<th>Signal</th>
<th>View</th>
<th>Window</th>
</tr>
</thead>
<tbody>
<tr>
<td>Undo</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Ctrl+Z</td>
</tr>
<tr>
<td>Cut</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Ctrl+X</td>
</tr>
<tr>
<td>Copy Row(s)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Ctrl+C</td>
</tr>
<tr>
<td>Paste Row(s)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Ctrl+V</td>
</tr>
<tr>
<td>Remove row(s)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Insert row</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Trigger Settings</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Auto Sync Settings</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Amplitude</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Channel Select</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Filter Amplifier Control</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Trigger Settings

![Trigger Settings Diagram]

Please read chapter "Trigger Settings" in "Synchronizing Events".

### Auto Sync Settings

![Auto Sync Settings Diagram]
Please read chapter "Auto Sync Settings" in "Synchronizing Events".

Amplitude

5.1.3 STG Menu

Please read chapter „Select Device“ in „Setting up and Connecting the STG4002-opto“.

5.1.4 Batch Menu

5.1.5 Signal Menu
5.1.6 View Menu

<table>
<thead>
<tr>
<th>View</th>
<th>Window</th>
<th>Setting</th>
</tr>
</thead>
<tbody>
<tr>
<td>✔️</td>
<td>✔️</td>
<td>✔️</td>
</tr>
<tr>
<td>Tool Bar</td>
<td></td>
<td>Status Bar</td>
</tr>
</tbody>
</table>

5.1.7 Window Menu

<table>
<thead>
<tr>
<th>Window</th>
<th>Setting</th>
<th>Help</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cascade</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Tile</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Arrange Icons</td>
<td></td>
<td></td>
</tr>
<tr>
<td>1 MC_Stim1</td>
<td></td>
<td></td>
</tr>
<tr>
<td>✔️ 2 MC_Stim1STG4002-opto.stm</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

5.1.8 Settings Menu

<table>
<thead>
<tr>
<th>Setting</th>
<th>Help</th>
</tr>
</thead>
<tbody>
<tr>
<td>✔️ Enable compiler warnings</td>
<td></td>
</tr>
<tr>
<td>✔️ Start STG after Batch Download</td>
<td></td>
</tr>
<tr>
<td>Autorepeat Batch Mode</td>
<td></td>
</tr>
<tr>
<td>✔️ X Axis Time Format</td>
<td></td>
</tr>
<tr>
<td>Auto Sync</td>
<td></td>
</tr>
<tr>
<td>STG Device Setup</td>
<td></td>
</tr>
<tr>
<td>ASCII Import</td>
<td></td>
</tr>
<tr>
<td>Independent Channel Download</td>
<td></td>
</tr>
</tbody>
</table>

Enable Compiler Warnings

Cancel this option to disable the message boxes displaying compiler warnings during stimulus download.

The two error messages that can be disabled are: "Warning: signal length shorter than the maximum" and "Warning: non zero last amplitude value". They may present a nuisance if you download multiple stimulus files in batch mode, or if you want to adjust the stimulus intensity level on the fly.

On the Settings menu, select or deselect Enable Compiler Warnings.
STG Device Setup

Please select the connected stimulus generator device and the channel configuration via drop down menus.

5.1.9 Help Menu

About MC_Stimulus II

MC_Stimulus II Version 3.5.0 for STG4002opto
Copyright © 2003-2016 Multi Channel Systems MCS GmbH

STG info
- Status: OK
- STG: STG4002
- Voltage Range: ± 8000 mV (1.0 mV Resolution)
- Current Range: ± 1600 mA (0.2 mA Resolution)
- DAC Resolution: 14 Bits
- SW-Version: 3.5.0
- HW-Version: Rev. C
- Ser.No.: 00001
6 Operating the STG4002-opto

6.1 Operation Overview

Warning: Make sure that you do not come in contact with the cables or the connectors of the STG after you have started the STG. The high voltage and power can lead to injuries.

Warning: Do not start the STG if you are unsure about the channel configuration or the nature of the downloaded file.

1. Set up your experiment.
2. Switch the STG on.

Note: It is recommended to start the STG4002-opto ten minutes before use to allow warming up!

1. Set up your stimuli with the MC_Stimulus II program.
2. Send the stimulus sequence from a MC_Stimulus II file to the STG.
3. Start the STG either manually by pressing the Start / Stop button on the front panel, with the software controls, or with an external trigger.

Creating Stimuli

Stimuli are created user-friendly by entering the desired pulses (rectangular, ramp, or sine waveforms) into a MC_Stimulus worksheet. Waveforms can be combined freely to create virtually any stimulus pattern. Created stimuli are displayed in a WYSIWYG window.
Starting Stimulation

Note: You need a computer connection only when you are using the software controls for starting and stopping the stimulus generator. When you are using the STG interface or an external control, a trigger for example, you can disconnect the stimulus generator from the computer and operate it independently. But you cannot remove the STG from the power connection. The memory is cleared when the STG has lost power.

After the download of the stimulus file on the STG, you can start the stimulation. There are several ways to start the STG.

MC_Stimulus II Interface

You can start the stimulation directly after the download (with the command Download and Start or also later with the command Start. You can stop stimulation with the command Stop.

Starting the STG by using the Start command is considered as activating all trigger inputs, that is, all channels are started, and all Sync Out outputs are active. Likewise, all channels are stopped when you click Stop.

You can start the stimulation after download on both trigger separately. Please use the combined LED / Start / Stop buttons. You can start and stop the stimulation manual whenever you want by clicking the corresponding LED / Start / Stop button. The LED indicates the status: Grey means trigger off, red means trigger on. The first button on the left side belongs to trigger 1, the second button to trigger 2.

STG interface

You can start the stimulation by pressing the Start / Stop button on the front panel of the STG. Press the button again to stop the stimulation. Starting the STG by pressing the Start / Stop button is considered as activating all trigger inputs, that is, all channels are started and stopped, and all Sync Out outputs are active when the STG is started. Pressing the Start / Stop button stops the stimulation if at least one channel is still active in the moment of the trigger event (indicated by the lighting SWEEP LED). Pressing the button starts stimulation only if no channel is active (dark SWEEP LED).

External Control

You can start the stimulation on a trigger from an external device, for example, a switch. You can use both trigger inputs that independently trigger the analog output channels that you have assigned to them. The trigger works in a similar way as when you press the Start / Stop button. You can choose the action that will be taken when one of the channels that are assigned to the respective trigger input is still active. Either the stimulus protocols on the triggered channels are stopped or restarted; or the trigger event is ignored. There is also a separate Sync Out output for each Trigger In trigger input. You can assign the Sync Outs to the trigger inputs. The default settings define that Sync Out 1 is active when Trigger In 1 is triggered, and so on. Please see chapter “Trigger Settings” for more details.

STG Status Control

Three status control LEDs (light-emitting diode) are present on the front panel of the STG to give you a quick overview on its status.

| POWER | STG has been switched on. |
| PROG  | Stimulus file was downloaded to STG. STG is now ready for operation. |
| SWEEP | Stimulation is running, that is, at least one output channel is active. |
MC_Stimulus II Status Control

The top part of the MC_Stimulus II status control refers to the active instance of the MC_Stimulus program instance and the STG that is controlled by this instance. All information in this part is saved on the STG. The information is updated in the MC_Stimulus II main window when the connection to the STG is changed or interrupted.

<table>
<thead>
<tr>
<th>Status light</th>
<th>Color</th>
<th>Meaning</th>
</tr>
</thead>
<tbody>
<tr>
<td>Connected</td>
<td>Green</td>
<td>The STG is connected and switched on. The serial number serves as an ID for the controlled STG and is displayed on the left. On the STG menu, click Select Device to select another STG connected to a different USB port from the drop down list to switch STGs.</td>
</tr>
<tr>
<td>Programmed</td>
<td>Green</td>
<td>Stimulus file in voltage mode has been downloaded to the STG. The STG is now ready for operation. File name and path of the *.stm file that was downloaded onto the STG are displayed on the right.</td>
</tr>
<tr>
<td></td>
<td>Orange</td>
<td>Stimulus file in current mode has been downloaded to the STG. The STG is now ready for operation. File name and path of the *.stm file that was downloaded onto the STG are displayed on the right.</td>
</tr>
<tr>
<td>Sweep</td>
<td>Red</td>
<td>Indicates the active trigger. Each stimulation channel can be assigned to any trigger. If all channels are assigned to trigger one for example, only one sweep indicator will light up, even though all stimulation channels can be active. See also Triggering Stimulation.</td>
</tr>
</tbody>
</table>

6.1.1 Autocalibration

During the first ten minutes after starting the STG, the device emits every minute high frequency signals (small bursts) for internal offset calibration of the current outputs in a range of +/- 10 mV. After warming up the STG, the calibration signals later will be delivered half-hourly.

**Note:** It is recommended to start the STG ten minutes before use to allow warming up!

High sensitive measuring equipments will monitor these calibration signals as artefacts which might disturb the stimulation when using very low stimulus pulses < 100 μA in current mode. Enable the option “Disable Autocalibration” in STG main menu to avoid the autocalibration. Download the command to the STG.
6.1.2 Operating multiple STGs

If you have more than one STG connected to the same computer, please click under "STG" in main menu “Select Device”. In the “Select Device” dialog you can choose which STG you like to control from the currently active MC_Stimulus II program.

- The serial number is printed on the STG’s case. The serial number of the currently active STG is displayed on the status bar of the currently active instance of the MC_Stimulus II program.
- Click Select Device under STG in main menu. Select the serial number of the desired STG from the STG list.
- You can open multiple instances of the MC_Stimulus II program and control multiple STGs at the same time. Please make sure that you control each STG only by one MC_Stimulus II instance.
- You can also open only one MC_Stimulus II instance and control multiple STGs one after the other by the same instance. Simply change the settings in the Select Device dialog and select the next STG when you have finished to program the first. The STGs can be operated without a computer connection.
7 MC_Stimulus II Worksheet

You can freely combine positive pulse types. Use a separate row for each pulse type.

**Note:** Several tools are provided for editing whole columns at once or autocreating entries.

1. Select the desired output type first. Click Current under Output Mode on the file window of MC_Stimulus II.

   ![Output Mode](image)

**Note:** In current mode, a protection switch disconnects the current source from the electrode, to avoid leak currents. The switch opens as soon as the stimulation pattern starts. To allow some time for the switch to open, it is recommended to start current pulses with a short period of 0 μA. 40 μs is sufficient.

2. Click a tab to select an output channel. The according channel worksheet is brought to front.

   ![Channel Worksheet](image)

3. Now you can enter the pulses into the worksheet. Select a Pulse type either rectangular, ramp, or sine.

   ![Pulse Worksheet](image)

4. Enter the desired current steps and a time length for each step.
5. The according pulse is displayed in the WYSIWYG display at once.

7.1 Pulse Types

Three basic pulse types are available in MC_Stimulus II. You can create virtually any pulse by combining different types: Rectangular, Ramp, Sine wave.

Note: The time resolution is 20 μs. When you enter time steps that are not a multiple of 20 μs, the length of the step is internally adjusted (rounded arithmetically, that is, 249 μs would be rounded down to 240 μs, 250 would be rounded up to 260 μs) to a valid value. Please regard also the minimum and maximum output current of your STG4002-opto version. If you enter current values outside the STG’s limit, the invalid value will be changed automatically when you download the protocol. Cells with changed values will be highlighted in yellow.

Note: If you work near the resolution limits of the STG, the output pulses may differ from the programmed pulses. In this case, you should check the output with an oscilloscope. Please see also the “Analog Output Signals” chapter. Please note that the memory of the STG4002-opto is limited (64 MB). You will get an error message if the memory is full.

For the digital Sync channels, only TTL pulses with bit patterns of 0 (LOW) and 1 (HIGH) can be programmed. A logical state of 1 (HIGH) results in a 3.3 V output signal, and a logical state of 0 (LOW) results in a 0 V output. Please note that the digital output is sent about 20 μs faster than the analog output.
Rectangular Pulses

Enter each current level and the duration of the pulse. The current jumps directly to the specified level. In one row, you can enter up to three current levels. Use the next row for programming more levels.

Ramp pulse type

Define the starting point, end point, and the length of the ramp. The ramp is then build according to these parameters in small single steps of 20 μs.

Sine wave pulse type

Define the amplitude and the period of the sine wave. The sine wave is then computed according to these parameters with a minimum resolution of 1 mV and 20 μs. If you enter a negative amplitude, the sine wave starts with its negative alternation.

Autorepeating Pulses and Protocols

For entering complex stimuli easier and faster, you can repeat rows and groups instead of entering the pulses several times into the worksheet. You can repeat each single row. You can also group several rows and repeat them altogether.

Repeating rows

Type the number of repeats into the Row Repeat cell of the appropriate row. The pulses of the complete row are repeated the specified number of times.

Grouping and repeating groups

1. Select several cells by clicking and dragging cells in the Group Repeat column. Selected cells are highlighted in black.
2. Point to the selected cells and right-click to open the context menu.
3. Click Group / Ungroup. The corresponding rows are grouped now. This is indicated by a merging of the Group Repeat cells.
4. Type the number of repeats into the merged Group Repeat cell.

Repeating complete pulse protocols (autorepeat function), Continuous Mode

You can repeat the complete stimulus on all output channels that are triggered by the same trigger. This means, each time when a trigger event occurs, the complete stimuli on all corresponding output channels are repeated for the specified number of times. If the stimuli have different lengths, the starting points are synchronized. For example, if channel 1 has a stimulus with a length of 500 ms, and channel 2 of 1000 ms, and both are triggered by the same trigger event, channel 1 waits 500 ms for the repeat until the output stream of channel 2 has been finished.
Note: The Sync Out signal for the corresponding trigger is repeated as well each time the stimulus is repeated.

Hint: You can repeat the complete stimulus protocol that is assigned to a trigger continuously by using the Continuous Mode setting. Continuous mode can be activated in the main window or under Trigger Settings. The STG has then to be stopped manually by the user. You can use this feature regardless whether you use an external trigger input or not. When you press the Start button, this is considered as if all trigger inputs were active. When you use Continuous Mode, the repeats entered in the Trigger Settings dialog box are disabled.

On the Edit menu, click Trigger Settings.

Enter the number of repeats for each trigger separately. 0 repeats the output signals continuously. In the following example, the stimuli on output channels 1 and 2 triggered by Trigger 1 are repeated three times after the trigger event, each time accompanied by the Sync Out 1 output. All other stimuli are applied once after their respective trigger event.

Repeating complete pulse protocols, Gating Trigger

Repeated stimulation of complete protocols can also be controlled by a gating trigger. Channels associated with a Trigger input will be active as long as the condition of that Trigger is 1 (HIGH) and switched off as soon as the condition becomes 0 (LOW). Gating trigger function can be enabled in the Trigger Settings menu.
7.1.1 Auto Sync for Autocreating Trigger Pulses

If you want to synchronize other devices, for example, the MEA2100 amplifier you have to set up the digital output of the Sync Out channels in synchrony to the stimulus pulses. This may sometimes be a bit tricky and time consuming, especially for complex stimulus protocols.

The Auto Sync feature is intended for making the work with MC_Stimulus II more efficient: Digital Sync Out TTL pulses synchronous to stimulus pulses are generated automatically by this feature. Each time an analog channel generates a pulse (that is, its value is not equal to zero), the logical state of the assigned Sync Out channel is set to HIGH (=1). You can set the time offset of the TTL’s rising edge before the stimulus pulse and of the TTL’s falling edge after the pulse. If you change the stimulus protocol, corresponding Auto Sync pulses are updated on the fly. This feature is especially recommended for controlling the MEA2100 amplifier with superior stimulus artifact suppression.

On the Edit menu, click Auto Sync Settings. The Auto Sync Settings dialog box appears.

Assign the analog stimulus channels that will be used as the basis for autocreating the protocols on the Sync Out channels 1 and 2. For example, if you use only stimulus channel 1, select Ch1 under Sync1. If you use a MEA2100 amplifier, you can use up to two output channels per amplifier, that is, you may want to select Ch1 and Ch2 for Sync1.

Set the time offset of the TTL’s rising edge before the stimulus pulse (Pre Time) and of the TTL’s falling edge after the pulse (Post Time). For operating a MEA2100 amplifier, a Pre Time of 0 μs and a Post Time of 100 μs are default, but especially the Post Time may have to be adjusted according to your stimulus amplitude and the stimulus artifact suppression performance.

On the Settings menu, click Auto Sync to enable the Auto Sync feature. The Sync Out protocols will be autocreated in synchrony with the pulse protocols on the assigned channels, will show up in the WYSIWYG window immediately, and will be downloaded onto the STG with your next download. Please make sure that the display and download options are appropriate, that is, all necessary Sync Out channels are selected. The worksheets of the Sync Out channels assigned to the Auto Sync feature will be unavailable, that is, you cannot edit them manually. The following screen shot shows an example of a monophasic 100 μs voltage pulse on channel 1 and the corresponding Auto Sync pulse (Pre Time 0 μs, Post Time 100 μs) on Sync Out 1.

If you later choose to edit the Sync Out worksheets of the active file manually, you can deselect the Auto Sync feature on the Settings menu. Any information in the Sync Out worksheets that was there before the Auto Sync option was enabled will be restored; and all worksheets will be available for manual editing.
7.1.2 Adjusting the Stimulus Intensity Level

After having programmed the stimulus protocol, you can either download the protocol "as is", or you can adjust the stimulus intensity level, that is, choose a percentage (from 0 to 200 percent) of the programmed amplitudes, independently for both channels. You can adjust the level offline and download the information onto the stimulus generator manually afterward, or you can adjust the level on-the-fly, without stopping the running stimulation. This feature is especially convenient for testing out thresholds that evoke a biological response.

Note: The error messages that are displayed when the stimulus amplitude is not set to zero at the end of the protocol or when the time length of stimulus protocols is different on individual channels can present a nuisance when adjusting the level on-the-fly. These error messages can be switched off by deselecting the option Enable Compiler Warnings on the Settings menu.

1. On the Edit menu, click Amplitude. The Amplitude dialog box opens. You can drag and drop it anywhere you like on the screen, also outside the main window of the MC_Stimulus II program. This is especially convenient when you are using two monitors.

2. Select the option Auto Download if you want to adjust the stimulus intensity level on-the-fly. Deselect the option if you want to download the changes manually later.

3. Select the option Change All if you want to adjust the stimulus intensity to the same level on all channels. Deselect the option if you want to set individual channels to different levels.

4. Drag the slider with the mouse for adjusting the stimulus intensity in the range of 0 to 200 percent of the programmed stimulus amplitudes. The WYSIWYG display is updated automatically. The worksheet is not updated. It always relates to the stimulus protocol that you programmed initially. If Auto Download is selected, changes are immediately downloaded onto the stimulator after releasing the slider, and the stimulus protocol is restarted from the beginning, with the adjusted stimulus intensity level.

5. If Auto Download was not selected, you need to download the stimulus protocol manually for changes to take place.

6. You can click the Reset All button to set the level on all channels back to 100 percent. Channel 1 is set to 75 %, that is, the stimulus protocol will be downloaded onto the stimulus generator as it was programmed in the worksheet. Channel 2 is set to 125 %.
7.2 Stimulus Display

7.2.1 Selecting Channels

To enlarge the display size of the channels, we suggest that you show only those channels you are currently working with.

Note: This will affect only the display. It has no effect on the download of signals. To select or deselect channels for downloading, click the Download Channel or Download Sync check boxes in the main window of the program.

Clear the check box of all channels that are not in use.

All channels that are not selected are removed from the display.

7.2.2 Display Settings

You can toggle between a decimal time scale in seconds (floating point numbers) and a time of day scale in the format hh:mm:ss:zzz, where h means hour, m is minute, s is second, and z is millisecond. Under Settings, click x-axis Time Format. Select the option to enable the time of day scale. Deselect the option to switch to the decimal time scale.

7.2.3 Display Tools

Several tools are provided to optimize the graphical presentation of the stimuli. If you later choose to display channels, the axes of the new displays are set to the default values. The time axis can display only positive values. The y-axis of the Sync Out channels cannot be adjusted, because only values of 0 and 1 are available for these channels.

<table>
<thead>
<tr>
<th>Tool</th>
<th>Function</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable scrolling</td>
<td>Scroll the axes by clicking and dragging with your mouse.</td>
</tr>
<tr>
<td>Enable scaling</td>
<td>Zoom the axes by clicking and dragging with your mouse.</td>
</tr>
<tr>
<td>Zoom out</td>
<td>Reduces the time scale.</td>
</tr>
<tr>
<td>Zoom in</td>
<td>Magnifies the time scale.</td>
</tr>
<tr>
<td>Reset</td>
<td>Resets the axes of all channels to the default values.</td>
</tr>
<tr>
<td>Size to fit</td>
<td>Adjusts the ranges to fit the largest displayed stimulus.</td>
</tr>
<tr>
<td>Show measure tool</td>
<td>A horizontal bar is shown that displays the current and the time value of the intersection point. Drag the bar with the mouse.</td>
</tr>
</tbody>
</table>
7.3 Downloading Stimulus Files

After having set up the stimulus file, you can download the file to the connected STG. You can select the channels you want to download or download the complete file. You can start the stimulation directly after the download, or start it manually with the software or hardware controls, or start it on a trigger. See also chapter "Operating the STG" for more information.

Warning: Check the file thoroughly before downloading it on the STG. The stimulus display is independent from the worksheet and from the download. Verify that you download only the channels that you want to use. Do not start the STG if you are not sure about the channel configuration or the nature of the downloaded file.

Select the channels for downloading under Download Channel and Download Sync.

<table>
<thead>
<tr>
<th>Download Channel</th>
<th>Download Sync</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>2</td>
</tr>
<tr>
<td>1</td>
<td>2</td>
</tr>
</tbody>
</table>

On the STG menu, click Download or click on the toolbar to download only the selected channels onto the STG or Download and Start to download only the selected channels and start the stimulation directly after the complete download.

Disable / Enable Warning Messages

Cancel this option to disable the message boxes displaying compiler warnings during stimulus download.

The two error messages that can be disabled are: "Warning: Signal length shorter than the maximum" and "Warning: Non zero last amplitude value". They may present a nuisance if you download multiple stimulus files in batch mode.

On the Settings menu, select or deselect Enable Compiler Warnings.
# 8 Synchronizing Events

**Digital Output Signals (Sync Out)**

The output of the digital Sync Out outputs is a 3.3 V TTL signal. A logic state of 1 means 3.3 V, and a logic state of 0 means 0 V. Please note that the digital output is about 15 μs faster than the analog output. This small offset is generally sufficient to make sure that the Sync Out signal precedes the stimulation, which is important for synchronizing events. You can program the output signal of the Sync Out channels in the same way as the analog output signals, but due to the nature of a digital signal, only values of 0 and 1 are allowed. A Sync Out signal is generated each time when the STG is started. The output signal can be used for triggering external devices, for example, the data acquisition with the MEA2100-System.

All available Sync Out outputs are active when the STG is started by pressing the Start / Stop button, or by using the software command Start on the STG menu.

If you are using the Trigger In inputs for starting the STG, each of the Sync Out channels is controlled by a separate Trigger In channel. Sync Out 1 is active when Trigger In 1 is triggered, Sync Out 2 is active when Trigger In 2 is active. The assignment of Sync Out channels to Trigger In inputs can be customized, please see chapter “Trigger Settings”. If you use the Repeat feature in the Trigger Settings dialog box, the corresponding Sync Out signal is repeated as well as the selected analog output signals. You can, for example, synchronize separate displays or other virtual instruments in the Multi Channel Experimenter software, one for each trigger input. You can also define a bit pattern in the Trigger Detector and trigger instruments on this bit pattern, for example to activate virtual instruments only when trigger 1 and 2 are active at the same time. Please see the Multi Channel Experimenter help or manual for more information on the Trigger Detector and triggering.

**Note:** No Sync Out signal is sent when the STG is stopped on a trigger event or by pressing the Start / Stop button, that is, if the trigger event occurs or the button is pressed when the STG has still been active.

**Triggering Stimulation (Trigger In)**

The external trigger input has to be a TTL signal of at least 40 +/- 10 μs length. TTL pulses shorter than that may not be recognized by the stimulus generator.

A TTL pulse is defined as a digital signal for communication between two devices. A voltage between 0 V and 0.8 V is considered as a logical state of 0 (LOW), and a voltage between 2 V and 3.3 V means 1 (HIGH). It is the same kind of signal as the output signal of the Sync Out output of the STG.

The rising edge of the HIGH trigger input starts and stops the STG. The time lag between the rising edge of the TTL input and the stimulus output is 30 +/- 10 μs. The minimum distance between two trigger inputs is 100 μs, resulting in a maximum trigger frequency of 10 kHz. If a higher frequency is used, the stimulus generator is likely to miss trigger inputs. See the illustration below for more details on the timing. Please note that the digital Sync Out output is about 15 μs faster than the analog outputs. See chapter “Digital Output Signal (Sync Out)” for more information.

You can either trigger separate output channels (Standard mode) or separate MC_Stimulus II files (Multi File mode).

There is also one separate Sync Out output for each trigger input. You can assign the Sync Outs to the trigger inputs in the Trigger Settings dialog box. The default settings are that Sync Out 1 is active when Trigger In 1 is triggered, Sync Out 2 is active when Trigger In 2 is active. See also “Digital Output Signals” for more information on the Sync Out channels.
The Sweep Status Display

The Sweep status display (LED Start / Stop buttons) in the main window of the program shows active sweeps that were started by the triggers. That means, the status lamp that corresponds to trigger 1 lights red as long as any channel triggered by trigger 1 is active. Please note that the number of the analog output channel is irrelevant, the Sweep status lamp refers only to the trigger number.

Example:

Assume that channel 2 is assigned to trigger 1. When channel 2 is active, the first Sweep lamp lights red, because the first Sweep lamp refers to trigger 1.

You can start and stop the trigger manually at any time using the LED Start / Stop buttons.

Timing limits

Stimulus output

Custom switch for "Remote Controlling" of the STG

You can connect any device that produces TTL outputs to the Trigger In connector of the STG, for example a switch. For example, you can use a trigger for remote controlling the STG if it is not within reach during an experiment. It is also possible to set up advanced experiments where stimulation depends on preceding activities of the studied object.

The following picture shows a suggested circuit diagram for a switch used for remote controlling. The resistor and capacitor work as a low pass filter on the TTL signal and are necessary to reduce ringing of the signal.

Suggested switch for triggering the STG
8.1 Trigger Settings

<table>
<thead>
<tr>
<th>File Mode</th>
<th>Cont Mode</th>
</tr>
</thead>
<tbody>
<tr>
<td>Standard</td>
<td>On</td>
</tr>
<tr>
<td>Multifile</td>
<td>Off</td>
</tr>
<tr>
<td>Extended Multifile</td>
<td>Off</td>
</tr>
</tbody>
</table>

8.1.1 Standard Mode

Triggering Output Channels (Standard Mode)

In the preceding example, trigger input 1 is used to trigger the output channel 1 and 2. This means, each time a TTL pulse is applied to Trigger In 1, stimulation on channels 1 and 2 is started simultaneously. The complete protocols of these two channels would be executed five times after the trigger event, if continuous mode would be off. However, as continuous mode is activated, trigger repeats are disabled and the protocols will be repeated indefinitely, until a manual stop occurs.

Important: Only channels assigned to the same trigger have the same time base. Between channels assigned to different triggers, time shifts in the order of the STGs time resolution (20 μs) may occur.

The Sync Out outputs are assigned to their default trigger inputs, that is, Sync Out 1 is active when trigger 1 is active. You can change this assignment with the option buttons, for example, assign multiple Sync Outs to the same trigger.

The Sweep status light (LED Start / Stop buttons) indicates the trigger numbers that have been assigned to active channels.

Example: If channels 1 and 2 are assigned to trigger 1, and trigger 1 is started (either by the software controls, the Start button on the stimulus generator’s front panel, or the trigger input 1), the first Sweep status lamp indicates the active state of channel 1 or 2, even if one of the two channels has a shorter output sweep than the other and is not active anymore.

Triggered action when channel(s) still active

You can define what action should be taken when any of the channels assigned to the trigger are still active.

Please click the expand button to show the advanced options:
Stop: A following trigger input stops the stimulation on the assigned channels if at least one channel that has been assigned to this particular trigger is still active in the moment of the trigger event. The trigger event starts stimulation only if no channel that has been assigned to this trigger is active.

Restart: The stimulus protocols on all channels assigned to this trigger are started at the trigger event, regardless of the activity on these channels.

Ignore: The trigger event is ignored when any channel assigned to this trigger is active. The trigger event starts stimulation only if no channel that has been assigned to this trigger is active.

**Use Trigger as Gate**

Channels associated with a Trigger input will be active as long as the condition of that trigger is 1 (HIGH) and switched off as soon as the condition becomes 0 (LOW). If the stimulation protocol is shorter than the gate, it will stop at the predefined time, regardless of the gating trigger. If the stimulation protocol is longer than the gating trigger, stimulation will stop when the gating trigger ends. For example, if you want to produce a repeated rectangular pulses that last as long as the gating trigger is HIGH, you can do the following: Program a single rectangular pulse and activate the continuous mode. The pulses will start as soon as the gating trigger becomes HIGH, and stop as soon as the gating trigger becomes LOW. If the voltage of the stimulation channel is different from 0 at the time the gating trigger ends, the channel will be switched off immediately. If you stop the stimulating protocol manually during the gating trigger in HIGH, stimulation is stopped but immediately restarted, and goes on until the gating trigger ends.

**Warning:** Once selected, this setting will become the default setting for all opened files, until unselected. So if you observe unexpected behaviour when triggering the STG, check the Trigger settings.

**Single Trigger**

**Important:** This feature is available only with STG 4000 series. The MC_Stimulus II version 3.2.3 (or later) with firmware update must be installed.

Additional to the general trigger states “running” and “stopped” each trigger can now be set up in a new state, called “armed”. That means, the trigger is ready to start the stimulus protocol, but waiting for an external signal from the rear panel trigger inputs to execute the stimulus protocol one time only. In “armed” state, the “Sweep” LED on the front panel of the STG will light up in blue, but the brightness of the LED is not as brilliant as in “running” state.

Select “Single Trigger” if you want to start the stimulus protocol once via external trigger.

Set up your stimuli with the MC_Stimulus II program. Download the stimulus protocol from a MC_Stimulus II file to the STG. Arm the STG either manually by pressing the Start / Stop button on the front panel, or with software controls. To arm the STG via software, use the start icon in MC_Stimulus II main menu, or click the combined LED / Start / Stop button for the “Sweeps”.
When armed, the STG accepts one single trigger on its trigger input. The trigger input must be connected to the device which generates the trigger. To start the stimulus protocol a second time, the STG needs to be armed again manually. As long as the STG is armed, the LED in MC_Stimulus II appears blue to indicate the armed state.

The stimulation will automatically be started after applying the single trigger from the external device. The LED in will turn to red while the trigger is running and return to grey after the trigger has finished the stimulus protocol. The STG needs to be armed again to accept the next trigger.

It is possible to stop the stimulation at any time while the STG is armed or is running via Start / Stop button on the front panel of the STG or via software.

**8.1.2 Multi File Mode**

As an alternative to triggering separate channels in a single stimulus protocol, you can also trigger up to two separate stimulus files in the Multi File mode. This feature allows you to trigger different stimulus protocols on overlapping channels. For example, you can control stimulus pattern A by trigger 1 on channels 1 and 2, and stimulus pattern B by trigger 2 on channels 2.

The Multi File mode is indicated in the MC_Stimulus II status control bar in the main window. If you use the Multi File mode, you cannot use the trigger inputs anymore for triggering single channels. When you start the download, both selected stimulus files are downloaded onto the stimulus generator. When Trigger In 1 is active, the file assigned to Trigger 1 is started (with all downloaded output channels); when Trigger In 2 is active, the file assigned to Trigger 2 is started. You can choose what action should be taken when a trigger event occurs during the time when the assigned file is still playing.

If the STG is started by the START / STOP button on the front panel or the Start command of MC_Stimulus II, only the first / top selected file (this is usually the file assigned to trigger 1) in the Trigger Settings dialog box is started. For downloading and starting multiple files without triggering, please use the Batch Mode.

**Important:** As long as you are in the Multi File mode, the Standard trigger settings (trigger inputs assigned to single channels) will have no effect. You also cannot close files if you are in Multi File mode.
Please leave the Multi File mode by selecting Standard under Mode in the Trigger Settings dialog box to use the standard trigger settings or before closing files.

1. Connect all necessary trigger inputs to TTL signal sources.
2. Set up your stimulus protocols and save the files.
3. On the Edit menu, click Trigger Settings.
4. Select the option Multi File.
5. Under Trigger 1, click Browse and select the appropriate stimulus protocol that you want to assign to trigger 1.
6. Repeat step 5 for both trigger inputs. Confirm the settings by clicking OK.
7. All selected files are opened automatically.
8. Check all stimulus protocols before download. Please make sure that you have selected all necessary channels under Download Channel for each file separately.
9. Download the files onto the STG by clicking Download on the STG menu.
10. The stimulation as specified in the selected MC_Stimulus files will now be triggered by the selected trigger inputs.
**Triggered action when channel(s) still active**

You can define what action should be taken when any of the channels assigned to the trigger are still active. In addition, you can also define what action should be taken when any of the channels not assigned to the trigger event are still active. Please click the expand button to show the advanced options:

- **Stop**: A following trigger input stops the stimulation on the assigned channels if at least one channel that has been assigned to this particular trigger is still active in the moment of the trigger event. The trigger event starts stimulation only if no channel that has been assigned to this trigger is active.

- **Restart**: The stimulus protocols on all channels assigned to this trigger are started at the trigger event, regardless of the activity on these channels.

- **Ignore**: The trigger event is ignored when any channel assigned to this trigger is active. The trigger event starts stimulation only if no channel that has been assigned to this trigger is active.

**Example:**

File A is assigned to trigger 1 and file B to trigger 2. Consider the following two situations:

- Trigger 1 is activated, but channel 2 in file A is still active. As channel 2 from file A is assigned to trigger 1, the settings defined for "on channel assigned to same trigger" would be applicable.

- Trigger 1 is active, but channel 2 in file B is still active. As channel 2 from file B is assigned to trigger 2, the settings defined for "on channel assigned to other trigger" would be applicable.

**8.1.3 Batch Mode**

You can download and run several stimulus files one after the other in the Batch mode. The first file in the list is downloaded and started directly after the download, or started manually with the software or hardware controls, or started on a trigger. After the first file has been run, the next file in the list is downloaded, and so on, until the last file in the batch list has been run.

**Triggering a sequence of stimulation protocols**

The Batch mode is useful if you want to start a sequence of different stimulation protocols one after the other on the same trigger (Trigger 1). Please make sure that you have assigned all channels to Trigger 1 in the Trigger Settings dialog box. You set up the protocols and save them as separate stimulus files. Then, you set up a batch file with a list of the desired stimulus files.

- The first trigger event starts the first file in the list.

- When a file has been completed, the next file in the list is downloaded automatically.

- When a trigger event occurs after the file has been run, the next file is started, and so on.

- When a trigger event occurs during the run of a file, the run is stopped, and the next file in the list is downloaded. The next trigger event starts the next file.

- Deselect the option Start STG after Batch Download on the Settings menu if you want to start the protocols on a trigger or manually with the software or hardware controls. If the option Start STG after Batch Download on the Settings menu is selected, the STG starts each file directly after the download without waiting for a trigger event.

As an alternative to the Batch mode, you can also use separate trigger inputs to trigger separate output channels or separate stimulus files. This way, you can trigger up to four different pulse protocols (on separate channels). See chapter “Triggering Stimulation” for more details.

**Note:** Only Trigger 1 is available for triggering in Batch mode. Do not use any other trigger inputs.
Splitting up stimulation protocols to circumvent the memory limitation

If the option Start STG after Batch Download on the Settings menu is selected, the STG starts each file directly after the download, which is only useful in the (unlikely) case that you need to circumvent the memory limitation of the STG. Split up your pulse protocol into several stimulus files and run them in Batch mode.

Setting up a batch file

You have to set up a batch file (.stb) first, which lists the full path of all files that you like to download as a batch. The batch file has to be exactly in the following format. This example is a batch list with three different pulse protocols. Replace the file paths with the correct path of the files of your choice.

Multi Channel Systems MCS MC_Stimulus II
Batch Control File
Version 1.00
c:\Program Files\Multi Channel Systems\MC_Stimulus II\BatchExample\Baseline.stm
c:\Program Files\Multi Channel Systems\MC_Stimulus II\BatchExample\Tetanus.stm
c:\Program Files\Multi Channel Systems\MC_Stimulus II\BatchExample\TestResponse.stm

Operating the STG in Batch mode

Important: You can operate the STG in Batch mode only with a valid computer connection. A file in the batch list is only downloaded after the preceding file has been run.

1. On the Batch menu, click Open to open a batch file. The Open dialog box appears.
2. Browse your folders and select a valid batch file, for example the sample file Batch Example.stb in the MC_Stimulus II program folder.
3. The Batch Status Display opens. It lists all stimulus files in the batch and the duration of stimulation.

4. On the Batch menu, click Start to start the download of the first file in the batch list (and the STG if the option Start STG after Batch Download on the Settings menu is selected). The progress of the pulse protocol is displayed in the Status column of the Batch Status Display.

5. Click Stop on the Batch menu to stop the batch if necessary.

6. Close the Batch Status Display with the Close command.

Warning: The STG starts immediately after the download if the option Start STG after Batch Download on the Settings menu has been selected. Make sure to deselect this option if you do not want to start the stimulation right away.

Autorepeat option

If you select the Autorepeat Batch Mode option on the Settings menu, the batch is restarted with the first file after the last file in the batch has been finished.

8.1.4 Auto Sync for Autocreating Trigger Pulses

If you want to synchronize other devices, for example, the MEA2100 amplifier with the stimulus generator, you have to set up the digital output of the Sync Out channels in synchrony to the stimulus pulses. This may sometimes be a bit tricky and time consuming, especially for complex stimulus protocols. The Auto Sync feature is intended for making the work with MC_Stimulus II more efficient: Digital Sync Out TTL pulses synchronous to stimulus pulses are generated automatically by this feature. Each time an analog channel generates a pulse (that is, its value is not equal to zero), the logical state of the assigned Sync Out channel is set to HIGH (=1). You can set the time offset of the TTL’s rising edge before the stimulus pulse and of the TTL’s falling edge after the pulse. If you change the stimulus protocol, corresponding Auto Sync pulses are updated on the fly.

On the Edit menu, click Auto Sync Settings.

The Auto Sync Settings dialog box appears. Assign the analog stimulus channels that will be used as the basis for autocreating the protocols on the Sync Out channels 1 and 2. For example, if you use only stimulus channel 1, select Channel 1 under Sync 1. If you use a LED stimulator device with two LEDs, you can use up to two output channels per amplifier, that is, you may want to select Channel 1 and Channel 2 for Sync 1. The preceding screen shot shows an advanced setup that could be used, for example, for a setup with two LEDs, each connected with two analog STG channels and one Sync Out.
Set the time offset of the TTL's rising edge before the stimulus pulse (Pre Time) and of the TTL's falling edge after the pulse (Post Time). A Pre Time of 0 μs and a Post Time of 100 μs are default, but especially the Post Time may have to be adjusted according to your stimulus amplitude. On the Settings menu, click Auto Sync to enable the Auto Sync feature. The Sync Out protocols will be autocreated in synchrony with the pulse protocols on the assigned channels, will show up in the WYSIWYG window immediately, and will be downloaded onto the STG with your next download.

![Image of a 100 μs pulse on channel 1 and the corresponding Auto Sync pulse (Pre Time 0 μs, Post Time 100 μs) on Sync Out 1.]

Please make sure that the display and download options are appropriate, that is, all necessary Sync Out channels are selected. The worksheets of the Sync Out channels assigned to the Auto Sync feature will be unavailable, that is, you cannot edit them manually. The screen shot shows an example of a 100 μs pulse on channel 1 and the corresponding Auto Sync pulse (Pre Time 0 μs, Post Time 100 μs) on Sync Out 1. If you later choose to edit the Sync Out worksheets of the active file manually, you can deselect the Auto Sync feature on the Settings menu. Any information in the Sync Out worksheets that was there before the Auto Sync option was enabled will be restored; and all worksheets will be available for manual editing.
9 Troubleshooting

About Troubleshooting

Most problems occur seldom and only under specific circumstances. In most cases, it is only a minor problem that can be easily avoided or solved. If the problem persists, please contact your local retailer. The highly qualified staff will be glad to help you. Please inform your local retailer as well, if other problems that are not mentioned in this documentation occur, even if you have solved the problem on your own. This helps other users, and it helps MCS to optimize the instrument and the documentation. Please pay attention to the safety and service information. Please read also chapter “Important Safety Advice” in the first part of the manual. Multi Channel Systems MCS GmbH has put all effort into making the product fully stable and reliable, but like all high-performance products, it has to be handled with care.

Technical Support

Contact your local retailer immediately if the cause of trouble remains unclear. Please understand that information on your hardware and software configuration is necessary to analyze and finally solve the problem you encounter. If you have any questions or if any problem occurs that is not mentioned in this document, please contact your local retailer. The highly qualified staff will be glad to help you.

Please keep information on the following at hand

- Description of the error (the error message text or any other useful information) and of the context in which the error occurred. Try to remember all steps you had performed immediately before the error occurred. The more information on the actual situation you can provide, the easier it is to track the problem.
- The serial number of the device. You will find it on the device or click on the Help menu, click About.
- The software and hardware version you are currently using. On the Help menu, click About. The displayed dialog box shows the version numbers.
- The operating system and service pack number on the connected computer.
- The hardware configuration (microprocessor, frequency, main memory, hard disk) of the connected computer. This information is especially important if you have modified the computer or installed new hard- or software recently.
9.1 Errors

Signal terminated when using Trigger In
If you use the Trigger In to start the STG and the stimulation protocol is terminated right after start, check the Trigger Settings. If the Use Trigger as Gate function is selected, a protocol will only be active as long as the Trigger is HIGH. If the Single Trigger function is selected, the STG is armed and waits for an external trigger to execute the stimulus protocol one time only. Switch to Stop, Restart or Ignore.

Strong Peak Artifacts
Strong discharges or other artefacts of the output current.
Possible causes: One or both current outputs are open, that is, nothing is connected to them. The stimulus generator tries to hold a stable current against the indefinite resistance of the open current output. Therefore, the stimulus generator will increase the output voltage on the open current outputs to its maximum, which will result in a heavy load on the power supply. This situation may cause the power supply to become unstable, which may lead to artifacts on all channels.
In current mode: Connect the unused current output to ground (GND). Please see also the recommended setups in the chapter “Current Mode”.

Output Signal does not Match Programmed Signal
The amplitude or the duration of the output pulses differs from the programmed signal.
Possible causes: The stimulus protocol works near the resolution limits of the STG, that is, the pulses are very short or the amplitudes very low (smaller than 50 mV or 10 μA). Check the output signals with an oscilloscope and modify the pulse protocol so that the amplitude and timing of the pulses will match your requirements.
You operate the STG in current mode and the electrode resistance of the stimulating electrodes is too high. According to Ohm’s law, the LED resistance directly affects the kinetics of the current output. The rise time increases with an increasing electrode resistance. If the electrode resistance is too high for the compliance voltage, the output signal will be clipped.
Check the output signals with an oscilloscope and modify the pulse protocol so that the amplitude and timing of the pulses will match your requirements.

Internal Calibration Signals
The STG emits sometimes autonomous high frequency signals.
Cause:
During the first ten minutes after starting the STG, the device emits every minute high frequency signals (small bursts) for internal offset calibration of the current outputs in a range of +/- 10 mV. After warming up the STG, the calibration signals later will be delivered half-hourly.
The calibration is interrupted during stimulation.
High sensitive measuring equipments will monitor these calibration signals. Biological signals are usually slower than the high frequency bursts and will not interfere with the calibration signals.
When using MC_Stimulus II Version 3.5.0 and higher it is possible to avoid the internal offset calibration. Enable the command “Disable Autocalibration” in main menu “STG” and download the command to the STG.
10 Technical Specifications

Datasheet STG4002-1.6A-opto
Stimulus Generator 4002–1.6A-opto

Technical Specifications

<table>
<thead>
<tr>
<th>General</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating temperature</td>
<td>10 °C to 50 °C</td>
</tr>
<tr>
<td>Storage temperature</td>
<td>0 °C to 70 °C</td>
</tr>
<tr>
<td>Dimensions (W x D x H)</td>
<td>235 x 170 x 60 mm</td>
</tr>
<tr>
<td>Weight</td>
<td>1.2 kg</td>
</tr>
<tr>
<td>Fuse</td>
<td>Internal, 3.15 A slow</td>
</tr>
<tr>
<td>Number of analog output channels</td>
<td>2</td>
</tr>
<tr>
<td>Rise time (10 - 90 %) current</td>
<td>40 µs @ ΔI = 100 mA ...900 mA</td>
</tr>
<tr>
<td>Time lag between Sync Out and output</td>
<td>15 (± 2) µs</td>
</tr>
<tr>
<td>Output current</td>
<td>0 ... +1.6 A @ max. 5.5 V</td>
</tr>
<tr>
<td>Compliance voltage (between +I and –I)</td>
<td></td>
</tr>
<tr>
<td>Output current resolution</td>
<td>1 mA</td>
</tr>
<tr>
<td>Resolution</td>
<td>14 bit</td>
</tr>
<tr>
<td>Time resolution</td>
<td>20 µs</td>
</tr>
<tr>
<td>Output signals</td>
<td>Freely programmable (rectangular, ramp, sinus)</td>
</tr>
<tr>
<td>Maximum frequency (rectangular waveform)</td>
<td>25 kHz</td>
</tr>
<tr>
<td>Memory capacity for stored waveforms</td>
<td>64 MB</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Timing on external trigger</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Minimum time length of trigger input (TTL)</td>
<td>40 µs</td>
</tr>
<tr>
<td>Time lag between trigger in and Sync Out</td>
<td>70 (± 10) µs</td>
</tr>
<tr>
<td>Maximum trigger input frequency</td>
<td>10 kHz</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Interface and connectors</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Sync Out for synchronization</td>
<td>2 digital channels via coax cable</td>
</tr>
<tr>
<td>Trigger In for synchronization</td>
<td>2 digital channels via coax cable</td>
</tr>
<tr>
<td>Interface (connection to computer)</td>
<td>USB 2.0 High Speed</td>
</tr>
<tr>
<td>Download rate</td>
<td>Maximal 480 Mb per second</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Power supply unit (MPU30)</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Input voltage</td>
<td>90 – 264 VAC @ 47 – 63 Hz</td>
</tr>
<tr>
<td>Output voltage</td>
<td>11 – 13 V</td>
</tr>
<tr>
<td>Max. Power</td>
<td>30 W</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Software</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>MC_Stimulus II</td>
<td>Version 3.5.0 and higher</td>
</tr>
<tr>
<td>Operating system</td>
<td>Microsoft Windows ® 10, 8 and 7 (32 or 64 Bit), XP or Vista with NTFS, English and German versions supported</td>
</tr>
<tr>
<td>Data import / export</td>
<td>ASCII file format</td>
</tr>
</tbody>
</table>
11 Contact Information

Local retailer
Please see the list of official MCS distributors on the MCS web site.

User forum
The Multi Channel Systems User Forum provides the opportunity for you to exchange your experience or thoughts with other users worldwide.

Mailing list
If you have subscribed to the newsletter you will be automatically informed about new software releases, upcoming events, and other news on the product line. You can subscribe to the list on the contact form of the MCS web site.

www.multichannelsystems.com